
REFERENSI CEPAT SUBLIME TEXT
Navigasi, pengeditan, multi-cursor, pencarian, package

Navigasi
Navigasi File & Simbol
Ctrl+P Buka file cepat berdasarkan nama (fuzzy)
Ctrl+R Pergi ke simbol dalam file
Ctrl+Shift+R Pergi ke simbol dalam proyek
Ctrl+G Pergi ke nomor baris
Ctrl+; Pergi ke kata dalam file
Navigasi Tab & Panel
Ctrl+Tab Beralih antar tab yang terbuka
Ctrl+PageUp/Down Tab sebelumnya / berikutnya
Alt+1..9 Pindah ke tab berdasarkan nomor
Ctrl+K Ctrl+B Tampilkan/sembunyikan sidebar
Ctrl+` Tampilkan/sembunyikan konsol
Prefix Goto Anything
: Pergi ke baris (Ctrl+P lalu :42)
@ Pergi ke simbol (Ctrl+P lalu @func)
# Pergi ke kata (Ctrl+P lalu #search)

Pengeditan
Operasi Baris
Ctrl+Shift+K Hapus baris
Ctrl+Shift+D Duplikat baris
Ctrl+Shift+Up/Down Pindahkan baris ke atas / bawah
Ctrl+J Gabungkan baris
Ctrl+Enter Sisipkan baris di bawah
Ctrl+Shift+Enter Sisipkan baris di atas
Manipulasi Teks
Ctrl+Shift+U Huruf besar pada seleksi
Ctrl+K Ctrl+L Huruf kecil pada seleksi
Ctrl+K Ctrl+U Huruf besar pada seleksi (alternatif)
Ctrl+] Indentasi baris
Ctrl+[ Hapus indentasi baris
Ctrl+/ Alihkan komentar
Ctrl+Shift+/ Alihkan komentar blok

Seleksi
Perluas & Perkecil
Ctrl+D Pilih kata (ulangi untuk menambah 

kemunculan berikutnya)
Ctrl+K Ctrl+D Lewati yang sekarang, pilih kemunculan 

berikutnya
Ctrl+Shift+L Pecah seleksi menjadi baris-baris
Ctrl+L Pilih seluruh baris
Ctrl+Shift+M Pilih konten di dalam tanda kurung
Ctrl+Shift+A Pilih konten di dalam tag
Ctrl+Shift+Space Perluas seleksi ke scope
Pilih Semua Kecocokan
Alt+F3 Pilih semua kemunculan kata
Ctrl+Shift+F Cari dalam file (seluruh proyek)

Multi-Cursor
Menambah Cursor
Ctrl+Click Tambah cursor di posisi klik
Ctrl+D Tambah kemunculan berikutnya ke seleksi
Alt+F3 Pilih semua kemunculan sebagai cursor
Ctrl+Shift+L Tambah cursor di setiap baris yang dipilih
Ctrl+Alt+Up/Down Tambah cursor di atas / bawah
Alur Kerja Multi-Cursor
1. Select word: Ctrl+D
2. Add next match: Ctrl+D (repeat)
3. Skip match: Ctrl+K, Ctrl+D
4. Type replacement — edits all at once
5. Esc to return to single cursor

Pencarian
Cari & Ganti
Ctrl+F Cari dalam file
Ctrl+H Cari dan ganti
Ctrl+Shift+F Cari dalam file (seluruh proyek)
F3 / Shift+F3 Kecocokan berikutnya / sebelumnya
Alt+Enter Pilih semua kecocokan (di panel cari)
Ctrl+E Gunakan seleksi untuk pencarian
Ctrl+Shift+E Gunakan seleksi untuk penggantian
Opsi Pencarian (Alihkan di Panel Cari)
Alt+R Alihkan mode regex
Alt+C Alihkan sensitivitas huruf besar/kecil
Alt+W Alihkan pencocokan kata utuh
Alt+L Alihkan pencarian dalam seleksi

Command Palette
Penggunaan
Ctrl+Shift+P Buka Command Palette
type to filter Pencarian fuzzy perintah
Perintah Berguna
Set Syntax: [lang] Ganti syntax highlighting file
Convert Indentation Beralih antara tab dan spasi
Sort Lines Urutkan baris yang dipilih secara alfabetis
Reindent Lines Auto-indent seleksi
Install Package Buka installer Package Control
Toggle Word Wrap Alihkan soft wrapping

Build System
Perintah Build
Ctrl+B Jalankan build
Ctrl+Shift+B Pilih build system dan jalankan
F4 / Shift+F4 Hasil build berikutnya / sebelumnya

Build System Kustom
// Tools > Build System > New Build System
{
  "cmd": ["python3", "$file"],
  "selector": "source.python"
}

Package
Package Control
Ctrl+Shift+P → Install Instal package
Ctrl+Shift+P → Remove Hapus package
Ctrl+Shift+P → List Tampilkan package yang terinstal
Ctrl+Shift+P → Disable Nonaktifkan package
Package Populer
Emmet Ekspansi singkatan HTML/CSS
SublimeLinter Framework linting
GitGutter Tampilkan diff git di gutter
SideBarEnhancements Operasi file sidebar yang diperluas
A File Icon Ikon tipe file di sidebar
Terminus Panel terminal terintegrasi

Pengaturan
File Pengaturan
Preferences > Settings Buka pengaturan pengguna 

(JSON)
Preferences > Key Bindings Buka key binding pengguna
Project > Edit Project Pengaturan spesifik proyek
Pengaturan Umum
{
  "font_size": 14,
  "tab_size": 2,
  "translate_tabs_to_spaces": true,
  "trim_trailing_white_space_on_save": true,
  "ensure_newline_at_eof_on_save": true
}

Pola Umum
Pengeditan Split
Alt+Shift+1 Layout satu kolom
Alt+Shift+2 Layout dua kolom
Alt+Shift+3 Layout tiga kolom
Alt+Shift+4 Layout empat kolom
Alt+Shift+5 Layout grid (2x2)
Alt+Shift+8 Layout dua baris
Ctrl+Shift+[1..4] Pindahkan file ke group N
Shortcut Produktivitas
Ctrl+K Ctrl+0 Buka semua lipatan
Ctrl+K Ctrl+J Buka semua lipatan (alternatif)
Ctrl+K Ctrl+1..9 Lipat ke level N
Ctrl+Shift+[ Lipat seleksi
Ctrl+Shift+] Buka lipatan seleksi
F11 Alihkan layar penuh
Shift+F11 Alihkan mode distraction-free

Referensi Cepat Sublime Text | Sublime Text Documentation (sublimetext.com/docs) | MIT | refmint.com | 1/1



meta:
  title: "Referensi Cepat Sublime Text"
  subtitle: "Navigasi, pengeditan, multi-cursor, pencarian, package"
  category: "Tools"
  language: "id"
  updated: "2026-03-27"

provenance:
  derivation_type: "original"
  effective_license: "MIT"
  source_description: "Sublime Text Documentation (sublimetext.com/docs)"

sections:
  - title: "Navigasi"
    page_break_before: false
    subsections:
      - title: "Navigasi File & Simbol"
        type: table
        rows:
          - key: "Ctrl+P"
            desc: "Buka file cepat berdasarkan nama (fuzzy)"
          - key: "Ctrl+R"
            desc: "Pergi ke simbol dalam file"
          - key: "Ctrl+Shift+R"
            desc: "Pergi ke simbol dalam proyek"
          - key: "Ctrl+G"
            desc: "Pergi ke nomor baris"
          - key: "Ctrl+;"
            desc: "Pergi ke kata dalam file"

      - title: "Navigasi Tab & Panel"
        type: table
        rows:
          - key: "Ctrl+Tab"
            desc: "Beralih antar tab yang terbuka"
          - key: "Ctrl+PageUp/Down"
            desc: "Tab sebelumnya / berikutnya"
          - key: "Alt+1..9"
            desc: "Pindah ke tab berdasarkan nomor"
          - key: "Ctrl+K Ctrl+B"
            desc: "Tampilkan/sembunyikan sidebar"
          - key: "Ctrl+`"
            desc: "Tampilkan/sembunyikan konsol"

      - title: "Prefix Goto Anything"
        type: table
        rows:
          - key: ":"
            desc: "Pergi ke baris (Ctrl+P lalu :42)"
          - key: "@"
            desc: "Pergi ke simbol (Ctrl+P lalu @func)"
          - key: "#"
            desc: "Pergi ke kata (Ctrl+P lalu #search)"

  - title: "Pengeditan"
    page_break_before: false
    subsections:
      - title: "Operasi Baris"
        type: table
        rows:
          - key: "Ctrl+Shift+K"
            desc: "Hapus baris"
          - key: "Ctrl+Shift+D"
            desc: "Duplikat baris"
          - key: "Ctrl+Shift+Up/Down"
            desc: "Pindahkan baris ke atas / bawah"
          - key: "Ctrl+J"
            desc: "Gabungkan baris"
          - key: "Ctrl+Enter"
            desc: "Sisipkan baris di bawah"
          - key: "Ctrl+Shift+Enter"
            desc: "Sisipkan baris di atas"

      - title: "Manipulasi Teks"
        type: table
        rows:
          - key: "Ctrl+Shift+U"
            desc: "Huruf besar pada seleksi"
          - key: "Ctrl+K Ctrl+L"
            desc: "Huruf kecil pada seleksi"
          - key: "Ctrl+K Ctrl+U"
            desc: "Huruf besar pada seleksi (alternatif)"
          - key: "Ctrl+]"
            desc: "Indentasi baris"
          - key: "Ctrl+["
            desc: "Hapus indentasi baris"
          - key: "Ctrl+/"
            desc: "Alihkan komentar"
          - key: "Ctrl+Shift+/"
            desc: "Alihkan komentar blok"

  - title: "Seleksi"
    page_break_before: false
    subsections:
      - title: "Perluas & Perkecil"
        type: table
        rows:
          - key: "Ctrl+D"
            desc: "Pilih kata (ulangi untuk menambah kemunculan berikutnya)"
          - key: "Ctrl+K Ctrl+D"
            desc: "Lewati yang sekarang, pilih kemunculan berikutnya"
          - key: "Ctrl+Shift+L"
            desc: "Pecah seleksi menjadi baris-baris"
          - key: "Ctrl+L"
            desc: "Pilih seluruh baris"
          - key: "Ctrl+Shift+M"
            desc: "Pilih konten di dalam tanda kurung"
          - key: "Ctrl+Shift+A"
            desc: "Pilih konten di dalam tag"
          - key: "Ctrl+Shift+Space"
            desc: "Perluas seleksi ke scope"

      - title: "Pilih Semua Kecocokan"
        type: table
        rows:
          - key: "Alt+F3"
            desc: "Pilih semua kemunculan kata"
          - key: "Ctrl+Shift+F"
            desc: "Cari dalam file (seluruh proyek)"

  - title: "Multi-Cursor"
    page_break_before: false
    subsections:
      - title: "Menambah Cursor"
        type: table
        rows:
          - key: "Ctrl+Click"
            desc: "Tambah cursor di posisi klik"
          - key: "Ctrl+D"
            desc: "Tambah kemunculan berikutnya ke seleksi"
          - key: "Alt+F3"
            desc: "Pilih semua kemunculan sebagai cursor"
          - key: "Ctrl+Shift+L"
            desc: "Tambah cursor di setiap baris yang dipilih"
          - key: "Ctrl+Alt+Up/Down"
            desc: "Tambah cursor di atas / bawah"

      - title: "Alur Kerja Multi-Cursor"
        type: code
        content: |
          1. Select word: Ctrl+D
          2. Add next match: Ctrl+D (repeat)
          3. Skip match: Ctrl+K, Ctrl+D
          4. Type replacement — edits all at once
          5. Esc to return to single cursor

  - title: "Pencarian"
    page_break_before: false
    subsections:
      - title: "Cari & Ganti"
        type: table
        rows:
          - key: "Ctrl+F"
            desc: "Cari dalam file"
          - key: "Ctrl+H"
            desc: "Cari dan ganti"
          - key: "Ctrl+Shift+F"
            desc: "Cari dalam file (seluruh proyek)"
          - key: "F3 / Shift+F3"
            desc: "Kecocokan berikutnya / sebelumnya"
          - key: "Alt+Enter"
            desc: "Pilih semua kecocokan (di panel cari)"
          - key: "Ctrl+E"
            desc: "Gunakan seleksi untuk pencarian"
          - key: "Ctrl+Shift+E"
            desc: "Gunakan seleksi untuk penggantian"

      - title: "Opsi Pencarian (Alihkan di Panel Cari)"
        type: table
        rows:
          - key: "Alt+R"
            desc: "Alihkan mode regex"
          - key: "Alt+C"
            desc: "Alihkan sensitivitas huruf besar/kecil"
          - key: "Alt+W"
            desc: "Alihkan pencocokan kata utuh"
          - key: "Alt+L"
            desc: "Alihkan pencarian dalam seleksi"

  - title: "Command Palette"
    page_break_before: false
    subsections:
      - title: "Penggunaan"
        type: table
        rows:
          - key: "Ctrl+Shift+P"
            desc: "Buka Command Palette"
          - key: "type to filter"
            desc: "Pencarian fuzzy perintah"

      - title: "Perintah Berguna"
        type: table
        rows:
          - key: "Set Syntax: [lang]"
            desc: "Ganti syntax highlighting file"
          - key: "Convert Indentation"
            desc: "Beralih antara tab dan spasi"
          - key: "Sort Lines"
            desc: "Urutkan baris yang dipilih secara alfabetis"
          - key: "Reindent Lines"
            desc: "Auto-indent seleksi"
          - key: "Install Package"
            desc: "Buka installer Package Control"
          - key: "Toggle Word Wrap"
            desc: "Alihkan soft wrapping"

  - title: "Build System"
    page_break_before: false
    subsections:
      - title: "Perintah Build"
        type: table
        rows:
          - key: "Ctrl+B"
            desc: "Jalankan build"
          - key: "Ctrl+Shift+B"
            desc: "Pilih build system dan jalankan"
          - key: "F4 / Shift+F4"
            desc: "Hasil build berikutnya / sebelumnya"

      - title: "Build System Kustom"
        type: code
        content: |
          // Tools > Build System > New Build System
          {
            "cmd": ["python3", "$file"],
            "selector": "source.python"
          }

  - title: "Package"
    page_break_before: false
    subsections:
      - title: "Package Control"
        type: table
        rows:
          - key: "Ctrl+Shift+P → Install"
            desc: "Instal package"
          - key: "Ctrl+Shift+P → Remove"
            desc: "Hapus package"
          - key: "Ctrl+Shift+P → List"
            desc: "Tampilkan package yang terinstal"
          - key: "Ctrl+Shift+P → Disable"
            desc: "Nonaktifkan package"

      - title: "Package Populer"
        type: table
        rows:
          - key: "Emmet"
            desc: "Ekspansi singkatan HTML/CSS"
          - key: "SublimeLinter"
            desc: "Framework linting"
          - key: "GitGutter"
            desc: "Tampilkan diff git di gutter"
          - key: "SideBarEnhancements"
            desc: "Operasi file sidebar yang diperluas"
          - key: "A File Icon"
            desc: "Ikon tipe file di sidebar"
          - key: "Terminus"
            desc: "Panel terminal terintegrasi"

  - title: "Pengaturan"
    page_break_before: false
    subsections:
      - title: "File Pengaturan"
        type: table
        rows:
          - key: "Preferences > Settings"
            desc: "Buka pengaturan pengguna (JSON)"
          - key: "Preferences > Key Bindings"
            desc: "Buka key binding pengguna"
          - key: "Project > Edit Project"
            desc: "Pengaturan spesifik proyek"

      - title: "Pengaturan Umum"
        type: code
        content: |
          {
            "font_size": 14,
            "tab_size": 2,
            "translate_tabs_to_spaces": true,
            "trim_trailing_white_space_on_save": true,
            "ensure_newline_at_eof_on_save": true
          }

  - title: "Pola Umum"
    page_break_before: false
    subsections:
      - title: "Pengeditan Split"
        type: table
        rows:
          - key: "Alt+Shift+1"
            desc: "Layout satu kolom"
          - key: "Alt+Shift+2"
            desc: "Layout dua kolom"
          - key: "Alt+Shift+3"
            desc: "Layout tiga kolom"
          - key: "Alt+Shift+4"
            desc: "Layout empat kolom"
          - key: "Alt+Shift+5"
            desc: "Layout grid (2x2)"
          - key: "Alt+Shift+8"
            desc: "Layout dua baris"
          - key: "Ctrl+Shift+[1..4]"
            desc: "Pindahkan file ke group N"

      - title: "Shortcut Produktivitas"
        type: table
        rows:
          - key: "Ctrl+K Ctrl+0"
            desc: "Buka semua lipatan"
          - key: "Ctrl+K Ctrl+J"
            desc: "Buka semua lipatan (alternatif)"
          - key: "Ctrl+K Ctrl+1..9"
            desc: "Lipat ke level N"
          - key: "Ctrl+Shift+["
            desc: "Lipat seleksi"
          - key: "Ctrl+Shift+]"
            desc: "Buka lipatan seleksi"
          - key: "F11"
            desc: "Alihkan layar penuh"
          - key: "Shift+F11"
            desc: "Alihkan mode distraction-free"



{
  "title": "Referensi Cepat Sublime Text",
  "category": "Tools",
  "license": "MIT",
  "source": "Sublime Text Documentation (sublimetext.com/docs)",
  "derivation_type": "original",
  "version": "0.1.0",
  "backend": "typst",
  "variant": "letter-landscape-3col",
  "theme": "ink-saver",
  "density": "ultra-compact",
  "built_at": "2026-04-23T18:35:36+00:00",
  "git_sha": "dc9f08c"
}

